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Home Patrol Data Base (HPDB), ZIP Code Selection and Weather/SAME related 
functions can only be used within North America.

ABOUT THIS MANUAL

The AMBE+2™ voice coding Technology embodied in this product is protected by 
intellectual property rights including patent rights, copyrights and trade secrets of 
Digital Voice Systems, Inc.
The voice coding technology is licensed solely for use within this Communications 
Equipment. The user of this technology is explicitly prohibited from attempting to 
extract, remove, decompile, reverse engineer, or disassemble the object code, or in 
any other way convert the object code into a human-readable form.
US Patent Nos #7,970,606, #6,912,495 B2, #6,199,037 B1, #5,870,405, #5,826,222, 
#5,754,974, #5,701,390, #5,715,365, #5,649,050, #5,630,011, and #5,517,511. 
microSD is a registered trademark of SanDisk Corporation.
HomePatrol is a registered trademark of Uniden America Corporation, Irving, Texas.
At Uniden, we are always improving our products. This manual may not contain the 
latest improvements to this model.
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USING THIS MANUAL

This manual describes the functions and features of your scanner. It assumes that you know the 
basic structure of radio systems and how they work. Just as a car owner’s manual does not teach 
you how to drive, this manual does not teach you about radio systems. There are many resources 
for learning about radio systems, including wiki articles, forum discussions, and YouTube videos. 
We encourage you to start at RadioReference.com’s discussion forums.
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IMPORTANT INFORMATION

GENERAL PRECAUTIONS

Before you use this scanner, please read and observe the following:

Earphone Warning

You can use an optional 32Ω stereo headset or earphone with your scanner. Use of an incorrect 
earphone or headset might be potentially hazardous to your hearing. The output of the phone jack 
is monaural, but you will hear it in both headphones of a stereo headset.
Set the volume to a comfortable audio level coming from the speaker before plugging in the 
earphone or headset. Otherwise, you might experience some discomfort or possible hearing 
damage if the volume suddenly becomes too loud because of the volume control or squelch 
control setting. This might be particularly true of the type of earphone that is placed in the ear 
canal.

Liquid Exposure Warning

Uniden does not represent this unit to be waterproof. It is water resistant to JIS level 4. To reduce 
the risk of damage to this product, minimize exposure of this unit to rain or moisture. This product 
is not warrantied against water damage 
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The Uniden SDS100E is a digital TrunkTracker communications receiver. Its True I/Q™ receiver 
provides for improved digital performance in challenging RF environments. 
Built to JIS4 standards, it is rugged and weather resistant. Its customizable color display allows 
instant access to the information you want to see.

WHAT YOU HEAR

Your scanner has over 10,000 police, fire, ambulance, business, utility, and other agencies set for 
instant access. 

There are some communications that the public is locked out from monitoring. Your 
scanner cannot receive agencies that encrypt their communications; it also cannot receive 

agencies on some private proprietary systems.
Because there are so many different kinds of communications going on, you can turn on specific 
types of agencies you want to hear (and turn off those you don’t).

CREATE FAVORITES LISTS

You are not limited to using the included database. You can also create your own Favorites Lists 
which you can customize to your preferences.

AVOID TRANSMISSIONS

You can also select transmissions for your scanner to Avoid (ignore).

REPLAY TRANSMISSIONS

Your scanner’s Replay feature acts as an instant replay of the transmissions you’ve just heard. 
You can set how long a period Replay records for instant playback. This period can range from 
30 seconds to 240 seconds (4 minutes). While you can replay that recording immediately and 
continue replaying it, you cannot save it for future listening.

RECORD TRANSMISSIONS

With your scanner, you can record transmissions. When you begin recording, your scanner adds 
the Replay recording buffer to the recording. These recording sessions are saved and can be 
replayed on demand. Rename and delete sessions through the Review Recordings submenu. 

INTRODUCTION
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MAIN FEATURES
Water Resistant (JIS4) – Resistant to dust and damage caused by splashing water from any 
direction (when all jack covers are in place).

Customizable Color Display – You can set the display color for each field in the display. 
Additionally, for many fields you can select the information provided.

True I/Q™ Receiver – Designed to improve digital performance in even the most challenging RF 
environments. An I/Q receiver captures the complete signal waveform in 3 dimensions, allowing 
for improved error correction and digital signal recovery.

Location-Based Scanning – Allows you to set your location(s) by GPS coordinates for instant 
reception. 

Favorites Scan – Allows you to organize your Systems into Favorites Lists. The scanner can 
scan any combination of Favorites Lists and the Full Database.

microSD card (provided - 1 GB up to 32 GB supported) – For storing Favorites Lists, Profiles, 
all your settings, Discovery sessions,  and recording sessions.

GPS Compatible – Connect to a GPS receiver (not included) for precise system selection and 
continuing reselection when you travel. The scanner will automatically select what to scan based 
on your current location as provided by an external GPS unit.

Range Control – Lets you set how far out from your current location the scanner will search for 
channels in Favorites Lists.

Trunk Tracker V Operation – Scans APCO 25 Phase 1 and Phase 2, X2-TDMA, Motorola, 
EDACS, and LTR trunked systems, as well as conventional analog and P25 digital channels.

Instant Replay – Plays back up to 240 seconds (4 minutes) of the most recent transmissions.

Audio Recording – Capture transmissions for later playback.

Custom Alerts – You can program your scanner to alert when you receive a Channel or Unit ID, 
a Close Call hit, an ID is transmitted with an Emergency Alert, or a Tone-out hit. For each alert, 
you can select from 9 different tone patterns, 15 volume settings, 7 colors, and 3 flash patterns.

Multicolor LED Alert – The alert LED with 7 colors, Blue, Red, Magenta, Green, Cyan, Yellow, 
or White, can be used with your Custom Alerts.

Trunking Discovery – Monitors system traffic on a trunked radio system to find unknown IDs and 
automatically records audio from and logs new channels for later review and identification.

Conventional Discovery – Searches a range of frequencies to find unknown frequencies and 
automatically records audio from and logs new channels for later review and identification.

Scan by Service Types – Scan your channels by Service Type i.e. Fire, Police, Railroad, etc.
Multi-Level Display and Keypad light – Makes the display and keypad easy to see in dim light with 
multiple backlight levels.

Temporary or Permanent Avoid – For Systems/Sites/Departments/Channels.

System/Channel Number Tagging – Number tags allow you to quickly navigate to a specific 
Favorites List, System, or Channel.

Start-up Configuration – You can program each of your Favorites Lists with a Startup Key (0-
9) so that when you power up the scanner and press the key number, just those Favorites Lists 
assigned to the key will be enabled for scan.
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Close Call© RF Capture Technology – Lets you set the scanner so it detects and provides 
information about nearby radio transmissions. Close Call Do-not-Disturb checks for Close Call 
activity in between channel reception so active channels are not interrupted.

Broadcast Screen – Allows the scanner to ignore hits on known broadcast frequencies including 
pager frequencies in search and Close Call modes. You can also program up to 10 custom 
frequency ranges that the scanner will ignore.

Fire Tone-Out Standby/Tone Search – Lets you set the scanner to alert you if a two-tone 
sequential page is transmitted. You can set up to 32 Tone-Outs. The scanner will also search and 
display unknown tones. (For USA only)

PC Programming – Use the Sentinel software to manage your scanners Profiles, Favorites Lists,  
and firmware updates.

Priority/Priority w/DND Scan – priority channels let you keep track of activity on your most 
important channels while monitoring other channels for transmissions.

Priority ID Scan – Allows you to set priority to talkgroup IDs.

Intermediate Frequency Exchange – Changes the IF used for a selected channel/frequency to 
help avoid image and other mixer-product interference on a frequency.

Individual Channel Volume Offset – Allows you to adjust the volume offset for each channel.

Configurable Band Defaults – Allows you to set the step (5, 6.25, 7.5, 8.33, 10, 12.5,15, 20, 25, 
50 or 100 kHz) and modulation (AM, FM, NFM, WFM, or FMB) for 31 different bands.
Repeater Find – Allows the scanner to try to switch to the repeater frequency if an input frequency 
is found.

Adjustable Scan/Search Delay/Resume – Set a delay up to 30 seconds or a forced resume up 
to 10 seconds for each channel or search.

Data Naming – Allows you to name each Favorites List, System, Site, Department, Channel, ID, 
Location, Custom Search, and SAME group, using up to 64 characters.

Duplicate Input Alert – Alerts you if you try to enter a name or frequency already stored.

Quick Keys – You can assign up to 100 Quick Keys to your Favorites Lists, Systems, 
Departments, and Sites.

Search Avoids – You can temporarily Avoid up to 250 frequencies and permanently Avoid up to 
250 frequencies in any Search mode or Close Call mode.

10 Custom Searches – Lets you program up to 10 custom search ranges.

Search with Scan Operation – Lets you include Custom Search ranges during scan operation.

3 Search Keys – You can assign 3 of the number keys to start a Custom Search, Tone-Out 
Search, or Close Call Search.

Quick Search – Allows you to start searching at the displayed frequency or enter a frequency 
and start searching.

SAME Weather Alert/Priority – Lets your scanner alert you when a SAME alert is transmitted 
on a NOAA weather channel. You can also set a weather channel as a priority channel.

Built-in Battery Charger  – Allows you to charge the rechargeable batteries in the scanner from 
any USB port.
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INCLUDED WITH YOUR SCANNER

Accessories included in the box are:

• AC Adapter

• USB Cable

• Hand Strap

• MicroSD Card (installed)

• Lithium Ion Battery Pack

• SMA-BNC Antenna Adapter

• SMA type Antenna

• Belt Clip

• Printed Material
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BASIC USAGE INFORMATION

USING INTERNAL BATTERIES

The SDS100E is powered by a Lithium Ion battery.
When the scanner is turned on, the scanner does not charge the batteries. When the scanner is 
turned off, the scanner will charge the batteries. 
You charge the scanner’s battery by connecting a USB power source to the scanner’s USB mini 
connector and powering off the scanner. Note that the power source must be rated 1A or higher to 
charge at a full rate. If you connect to a PC or other lower-power USB source, charging will take 
longer. You can power the scanner by connecting to either the USB micro or mini connector, but 
only the mini connector can be used for charging.
The included AC adapter is rated at 2A and can power or charge the SDS100E
The scanner’s charge indicator is red during charge and green when complete.
Note: If the scanner gets too hot while charging, it will turn off automatically.

VIEW THE BATTERY LEVEL

You can set a custom display area to show the battery voltage level. See “Customizing the Display.”

UNDERSTANDING THE MEMORY

All information contained in the scanner is stored on a microSD card supplied with the scanner. 
This includes Favorites Lists, all the radio settings, and the Radio Reference database.

FAVORITES LISTS

Because the memory is based on the RadioReference database, the SDS100E has a different 
organization unlike banks and channels in older scanners, but more like Dynamic Memory 
Architecture (DMA) used for the last few generations of scanners. Favorites Lists follow the 
RR database structure of Systems that contain Departments that hold Channels (conventional 
frequencies or IDs) and then Sites to hold trunking frequencies. If you are familiar with DMA 
scanners, think of departments as being like channel groups.
Favorites Lists will allow you to store channels you find when you are scanning from the full 
database (the easiest way). They can contain channels from trunking systems and conventional 
systems. You can also manually add systems, (not single sites), departments and channels into 
Favorites Lists from the database as well as program new systems, departments, sites, and 
channels with the Sentinel software.
You can save up to 256 different lists in the scanner (and software) and associate them with any or 
all of your profiles. You can monitor one or more lists at a time and/or the database. You can also 
export your lists to a file to share them. Deleting a profile will not delete the lists associated with a 
profile. However, deleting a Favorites List will delete it from all profiles.

SYSTEMS

Systems hold all of your Sites, Departments, and Channels.
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TRUNKING SITES

Inside systems are trunked sites that hold the trunking frequencies for any trunking system and 
any band plan information needed. You need at least one site for each trunked system and some 
systems can have several sites.

DEPARTMENTS

Departments are created inside systems. Departments hold frequencies (channels) for 
conventional systems and Talk Group IDs (also called channels) for trunked systems.

SENTINEL SOFTWARE

MANAGE PROFILES

Profiles are “snapshots” of your scanner’s set up. A profile contains all configuration settings as 
well as all Favorites Lists, Avoids, and System settings. Sentinel can save multiple profiles so 
you can restore different profiles as you need them. For example, if you regularly visit a specific 
location, you can create a profile for that location. You can save it to Sentinel to use whenever 
you visit.

MANAGE DATABASES

Uniden updates the Database used in your scanner every week. You can decide how often 
you want to update the databases on your scanner. When you update them through Sentinel, it 
checks the website for the most current database and saves it in Sentinel. When you select Write 
to Scanner, the new database is updated in the scanner. Updating the main database does not 
update any Favorites List. Your customizations and selections are preserved.

HOW TO INSTALL SENTINEL SOFTWARE

1. Go to the scanner’s product page at     http://www.uniden.co.jp/english/product/Scanners/
sentinel_uehp_sds100e.html     and click the link for support files.

2. Download the latest version of Sentinel.
3. Unzip the file you downloaded, then click on setup.exe and follow the on-screen instructions 

to install Sentinel.

UPDATING FIRMWARE

Your scanner updates its firmware through Sentinel. In that process, Sentinel connects to the 
internet and checks for the current firmware version to download.
From time to time, Uniden will release firmware updates to improve existing functionality, add new 
features, or address issues found in its operation. Updating the firmware takes just a few minutes 
and is easily accomplished using the Sentinel Software you installed on your PC.
Simply connect your scanner to your PC using the supplied USB cable and select Mass Storage. 
Then, in Sentinel select UPDATE/Update Firmware and follow the on-screen prompts.
For information about what is included in each update, see:
•	 http://info.uniden.com/UnidenMan4/SDS100FirmwareUpdates
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DATA NAMING

Name any Favorites List, System, Site, Department, Channel, Location, Custom Search, Recording 
Session, Tone-Out, or SAME group using up to 64 characters.
To Enter a Character, turn the scroll control until the character you want appears. To move the 
cursor to the right, press the right soft key (>).
To move the cursor to the left, press the left soft key (<). To clear a character, press ./no.
To clear all characters, press./no twice. Press E/yes when finished to exit.

PRIORITY SCANNING

Priority Scan – When the scanner is scanning a Conventional System, it interrupts scanning, 
based on the Priority Interval and Max Channels settings, to check priority channels for activity. The 
more channels you have set to priority, the longer the interruption will be. The Favorites List(s) and 
System(s) containing the priority channel(s) have to be enabled (and not Avoided) or the scanner 
will display Priority Scan No Channel.

Priority DND – The scanner checks priority channels, based on the Priority Interval and Max 
Channels settings, only when not receiving other conventional channels so there is no interruption 
in scanning with conventional systems.

Priority ID Scan – This function is similar to conventional priority although there is no interruption 
during the transmission. Priority is checked in between transmissions, when the scanner is 
receiving the control channel, and during the channel delay period. The scanner can only look for 
priority IDs in the trunked system it is currently scanning.

Preemptive Priority ID Scanning – For Motorola systems that have channel priority active on the 
system, if you flag a channel as priority and the system also has that TGID identified as a priority 
channel, the scanner will preempt any current transmission if the TGID becomes active.
The highest priority is for channels in System Quick Key 0. The lowest priority is for channels in 
System Quick Key 99. Priority for priority channels in the same channel Department follows the 
order in which the channels were created.

To use Priority Scan, you must first set your Priority Channels.
To use Priority ID Scan, you must also enable Priority ID Scan for each system.
To toggle Priority Modes, press Func then ./no(Pri).

 Priority is always on for a trunked system if enabled.

SCANNING ORDER

With previous scanners, you selected banks to scan. With this scanner, you select Favorites Lists, 
Systems, Departments, and Sites to scan by assigning Quick Keys to them.
Scanning is performed in a mixture of FLQK order and SQK order. The scanner does not scan all 
Systems in one Favorites List and then move to the next List.
For each Favorites List with a quick key, starting with 0, the scanner scans each 0 SQK in FLQK 

order and then move to the next set of SQKs for each list.

Example:

FLQK 0, SQK 0; FLQK 1, SQK 0…. FLQK 98, SQK 99; FLQK 99, SQK, 99. Department and Site 
Quick Keys are scanned with each System.



10

Systems with the same quick key are scanned in order of creation.
The Database is scanned next, in order of creation. Then, Systems with no quick key (including 
created Quick Save Systems) are scanned and in order of creation.
Conventional Channels and Departments within Systems are also scanned in order of creation. 
IDs are not really scanned. The scanner checks for any activity in the trunking system and:
• Displays all IDs when ID Search mode is set to On.
• Displays only programmed IDs when ID Search mode is set to Off.
Next, any Custom Searches (enabled for Search with Scan) are scanned in order (Close Call Hits 
last).
Then, the scanner scans the Close Call ‘Hits with Scan’ system (if Unavoided). This is a system 
that automatically stores the frequencies found by Close Call. If the ‘Hits with Scan’ system has 
no frequencies, the scanner does not scan the system.
The scanner scans a system for the duration you set using the System Hold Time option. For 
trunked systems, the scanner moves to the next system after the hold time expires, the current 
transmission ends, and the channel delay expires. Conventional systems operate similarly, but all 
(Unavoided) channels are scanned at least one time regardless of the hold time setting.

SCANNING

Scanning Checklist:

1. You must enable at least one Favorites List or the Full Database in Select Lists to Monitor.
2. Favorites Lists or Systems, with Quick Keys assigned to them, must be enabled with quick 

keys or through Manage Quick Key Status.
3. Service Types required for channels must be set to On.

Any Favorites List not assigned to a quick key, not Avoided, and set to On in Select – to Monitor 
will be scanned. Any System, Department, or Site (or Quick Save System/Department) not 
assigned to a quick key and not Avoided, will be scanned.
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REPLAY THE LAST TRANSMISSIONS

While scanning, press Replay.
Press Channel to pause/resume replay.
Turn the Scroll Control to select recordings.

Replay is not available when recording is enabled.

START/STOP RECORDING

While scanning, press Func then Replay/Record.
Resets to Off when you turn off the scanner.

AVOIDING CHANNELS, DEPARTMENTS, SITES, AND SYSTEMS

Temporary Avoids are cleared when you cycle power. You must manually clear permanent avoids.

Channel Avoid

When the Channel is in the display or in Channel Hold mode: To Temporary Avoid, press Avoid 
once. To Permanent Avoid, press twice when the channel is in the display or in Channel Hold 
mode.

Department Avoid

Press Dept (soft key 2) then Avoid once to Temporary Avoid. Press Avoid twice to Permanent 
Avoid.

Site Avoid 

When the Site is in the display or in Site Hold mode (Func then Dept):
To Temporary Avoid, press Dept then quickly press Avoid.
To Permanent Avoid, press Dept then quickly press Avoid twice.
To Stop Avoiding, press Dept then Avoid once.
Press Func then Dept to release Site hold.

System Avoid

Press System then Avoid once to Temporary Avoid. Press Avoid twice to Permanent Avoid.



12

SETTING UP YOUR SCANNER

FIRST STEPS

To get your scanner ready for use, follow these quick steps:
1. Install the battery pack and plug the included cable into the scanner’s USB mini port and the 

other end into a PC.
2. Turn on the scanner by pressing  for about 2 seconds.
3. When prompted, select Mass Storage mode.
4. Run Sentinel.
5. Follow the steps provided on the previous page to update the scanner’s firmware and radio 

database to the latest versions.

INITIAL SETTINGS

1. Turn on the scanner by pressing and holding  for about 2 seconds.
2. Tap the scroll control to display the volume level. Turn the scroll control (within 3 seconds) to 

adjust the volume.
3. Tap the scroll control again to close the volume level (or let it disappear after 10 seconds).
4. Press Func then tap the scroll control to display the squelch level.
5. Tap the scroll control again to close the squelch level.

CONTROLS AND INDICATORS

The following table includes the most common functions for each key. It is not, however, a 
comprehensive list for all functions in all modes. See specific functions in this manual to perform 
a particular task.
The two LED indicators above the display indicate charge status (right LED; red when charging, 
green when charged) and channel alert indication (left LED).
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Button Operation 

Power/Light • Press and hold to turn the scanner on or off.
• Tap to turn on/off the display backlight. Note that when the display 

backlight is off, nothing is visible on the display.

Avoid • Press once to temporarily avoid the current channel or frequency (in 
direct tune mode).

• Press twice to permanently avoid the current channel or frequency.
• During scan, or scan hold press the left soft key (System), then tap 

avoid once (for temporary avoid) or twice (for permanent avoid) to avoid 
the currently scanned system.

• During scan, or scan hold press the middle soft key (Department), then 
tap avoid once (for temporary avoid) or twice (for permanent avoid) to 
avoid the currently scanned department.

Services • Press Func then Zip to select Service Types to be scanned.

Soft Keys The function of these three keys change depending on the current mode. 
The function is indicated by the labels at the bottom of the display.

Menu • Press to enter Menu mode.
• Press to return one level in Menu mode.
• Press Func then Menu for Search menu in Search mode.
• Press Func then Menu for Close Call menu in Close Call mode.

Replay/Record • Press to Replay the last transmissions.
• Press Func then Replay to start/stop recording
• Press and hold to Review Recordings.

Number keys 
(general) See 
individual key 
functions below 
for additional 
functions

• Press to select Favorites Lists in Scan mode.
• Press 0-9 to use direct entry in a Hold mode.
• Press 0-9 to toggle custom search bands on or off in Custom Search 

mode.
• Press 0-6 to toggle Close Call bands on or off in Close Call mode.

1 / SRCH1 • Press to enter the digit 1 in any numeric entry mode.
• In channel hold mode, press Func then 1 to toggle on/off the search 

you’ve assigned to SRCH1.

2 / SRCH2 • Press to enter the digit 2 in any numeric entry mode.
• In channel hold mode, press Func then 2 to toggle on/off the search 

you’ve assigned to SRCH2.

3 / SRCH3 • Press to enter the digit 3 in any numeric entry mode.
• In channel hold mode, press Func then 3 to toggle on/off the search 

you’ve assigned to SRCH3.
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Button Operation

4 / ATT Press to enter the digit 4 in any numeric entry mode.
In Channel hold mode, press Func then 4 to toggle attenuation on/ off for 
the current channel
In Channel hold mode, press Func then hold 4 for 3 seconds to toggle 
global attenuation on/off.
In Search mode, holding on a frequency, press Func then 4 to toggle 
attenuation on/off for the current frequency.

5 / DIM Press to enter the digit 5 in any numeric entry mode.
In Channel hold mode, press Func then 5 to set the display brightness 
level.

6 / WX Press to enter the digit 6 in any numeric entry mode.

7 / IFX Press to enter the digit 7 in any numeric entry mode.
In Channel hold mode on a conventional channel, press Func then 
7 to toggle intermediate frequency exchange on/off for the current channel.
In Search mode, holding on a frequency, press Func then 7 to toggle 
intermediate frequency exchange on/off for the current frequency.

8 / REV Press to enter the digit 8 in any numeric entry mode.
In Channel hold mode on a conventional channel, press Func then 8 to 
monitor the repeater input frequency for the current channel.
In Search mode, holding on a frequency, press Func then 8 to monitor 
the repeater input frequency for the current frequency.

9 / DISP Press to enter the digit 9 in any numeric entry mode.
In Channel hold mode, press Func the 9 to toggle between simple and 
detailed display modes.

0 / LVL Press to enter the digit 0 in any numeric entry mode.
In Channel hold mode, press Func then repeatedly press 0 to set the 
volume offset for the current channel.

./no/PRI Press to enter a decimal point for a frequency.
Press when prompted Yes/No to select No.
Press Func then./no to toggle conventional priority scan.

E/yes
Q. SRCH

Press to select a menu item or save an entry in Menu mode
In Channel hold mode, press to store a blinking CTCSS/DCS/NAC.
In Channel hold mode, press Func then E/yes to start a Quick Search.
Press Func then E/yes to toggle ID Search mode on/off in Scan mode 
(when scanning Trunked System in Favorites List only).
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UNDERSTANDING LOCATION, RANGE, AND SERVICES

All radio systems in your scanner’s database are tagged with location information. A geotag has 
latitude, longitude, and range. This tag describes a circle centered at the latitude/longitude that 
fully encompasses the entity (i.e. city, town, state, etc.) served by the radio system. Taking a look 
at some of the systems in the Fort Worth, TX area, you can see that each system has its own little 
circle. These roughly outline each system’s intended coverage.

Each entry also includes all the radio system information (frequencies, descriptions, tags 
indicating how each channel is used, etc).
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The scanner selects channels from systems that overlap the thick circle. So, the system down 
south that covers Burleson is included even though only part of it is covered, but Haslet, way up 
north, is not included.
Each location method uses a different range. In addition to the 10-mile Zip Code radius, the 
scanner uses:
• GPS or Manual Location: 0-miles radius.
0 miles means that your location is precisely known. For a radio system to be selected, its 
circle must enclose your precise position. This setting is great if you are traveling…the scanner 
automatically selects and deselects systems as you drive through each system’s coverage zone.
You can manually change the range setting to be bigger (to include more systems) or smaller (to 
include fewer systems) by going to the Range menu and adjusting the range up or down.
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SET UP GPS

Location Format

DMS:DDD˚MM’SS.ss or DEG:DDD.dddddd.

Set Serial Port

Default is 4800 bps for a GPS device.
Off, 4800, 9600, 19200, 38400, 57600, or 115200 bps.

Set Range

This setting allows you override the default range setting for your current location to increase or 
decrease the number of Trunking Sites and Channel Departments you can receive when you are 
scanning from the Full Database and when you are scanning Favorites Lists with Location Control 
enabled. See also Understanding Range, 18.
Enter the range (0-50) and press E/yes.

EDIT LOCATION

This lets you create a location or edit a location for rapid recall. First, select New Location or Edit 
Location.

Edit Name

See Data Naming, page 11.

Use Location

This will set the location as current for scanning the Database and any Favorites List with 
Location Control enabled.
At Confirm? Press E/yes or ./no.

Delete Location

You can only delete saved locations. The last location set will be retained for use when scanning 
the Database.
At Confirm Delete?, press E/yes or ./no.

Set Location Information

See Set Manual Location, 2.

Set Range

Enter the range (0-50) and press E/yes.

Save Location

This saves the current location and the range.



18

SELECTING SERVICE TYPES

By default only EMS Dispatch, Fire Dispatch, Law Dispatch, Custom 1, and Multi-Dispatch are 
enabled.
The Appendix has a list of Service Types and their general descriptions. To change the enabled/ 
disabled service types:

1. Press Func then the Zip/Services button.
2. Scroll to each Service Type and press E/yes to enable or disable. Press System to exit.

If a Service Type is not in any active Favorite List, the scanner will display “---”.
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QUICK NAVIGATION CONCEPTS

ASSIGNING QUICK KEYS

Quick Keys let you quickly turn on/off favorites lists, systems within a favorites list, and 
departments and sites within systems. There are three levels of quick key as described below.

FAVORITES LIST QUICK KEYS

Favorites Lists Quick Keys (FLQK) quickly enable or disable entire Favorites Lists for scanning. 
There are 100 FLQKs (00-99). These are like the bank keys used on older scanners. You do not 
have to assign a FLQK to a favorites list, but doing so makes it easier to modify what you are 
currently scanning. Each FLQK can only be used one time (i.e. two favorites lists cannot have the 
same FLQK).

SYSTEM QUICK KEYS

System Quick Keys (SQK) quickly enable or disable conventional and trunked systems for 
scanning. There are 100 SQKs (00-99). You can use the same SQK for multiple systems. 

DEPARTMENT/SITES QUICK KEYS

Department/Site Quick Keys (DQK) quickly enable or disable departments or sites. There are 100 
DQKs (00-99). You can use the same DQK for multiple departments and sites.

USING QUICK KEYS

To enable or disable a Quick Key, while scanning, enter all or part of:
FF.SS.DD then press E.

• FF=FQK
• SS=SQK
• DD=DQK

Examples:

• 10 E: Toggle FQK 10
• 10.03 E: Toggle SQK 03 in FQK 10
• 10.03.02 E: Toggle DQK 02 in SQK 03 in FQK 10.
• .03 E: Toggle SQK 03 in the currently scanned Favorites List
• ..04 E: Toggle DQK 04 in the currently scanned system.

Toggling a SQK or DQK only affects the quick key within the current hierarchy. If you have 
the same SQK under a different Favorites List, that SQK is unaffected.

You can assign a display area to indicate the FQK/SQK/DQK status. See Customizing the 
Display, on page 38.
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SEARCH KEYS

You can assign any search function to Search Keys (1, 2, or 3) to quickly go to  that search. Use 
the menu function Search for… → Set Search Key to assign the search functions. To start the 
search, hold on a channel, the press F+1, 2, or 3.

STARTUP KEYS

You can program each of your Favorites Lists with a Startup Key (0-9) so that when you power 
up the scanner and press the key number, just those Favorites List(s) assigned to the key will be 
enabled for scan. Systems are not affected. Assign a startup key when programming Favorites 
Lists.
To use a startup key, hold it down while powering on the scanner. Items with a matching startup 
key will be enabled for scanning. Items with a startup key that does not match will be disabled for 
scanning. Items with no startup key will not be affected.

NUMBER TAGS

Numbers tags will allow you to tag each Favorites List, System, and Channel so you can quickly 
go to that element. Number tags can range from 0 to 99 for Favorites Lists and Systems and 
0-999 for Channels.
To use a number tag, hold on any channel, then enter the tag as FF.SS.CC and press Channel (soft 
key 3).

CHANNEL/ID ALERTS

You can program your scanner to alert you when a Channel or Unit ID is received, you receive 
a Close Call hit, an ID is transmitted with an Emergency Alert or you receive a Tone-out hit. For 
each alert in the scanner, you can select from 9 different tone patterns, 15 volume settings, 7 
colors, and 3 flash patterns.

QUICK FREQUENCY TUNING

To quickly tune to a frequency and enter quick search mode:
1. Hold on any channel.
2. Key in any frequency.
3. Press CHAN (soft key 3).

QUICK TALK GROUP TUNING

To quickly tune to a talk group in the trunked system you are currently scanning, while scanning 
that trunked system:
1. Hold on any channel.
2. Key in the talk group ID.
3. Press CHAN (soft key 3).
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MENU REFERENCE

The scanner’s menu gives you access to all the scanner’s setting as well as programming. The 
table below provides a quick description of most of the scanner’s menu tree. For procedures that 
need more explanation, the table will indicate where in this manual to look for that explanation.
To access the menu, press  on the scanner’s left side. For ease of reference, this manual will 
refer to this button as MENU.
When describing menu navigation, this manual uses the following format: 
MENU → Main Menu Item → Sub Menu item
For example:
MENU → Search For… → Custom Search
To go up one menu level, press MENU. To exit the menu entirely, press AVOID.

Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Set Scan Selection Manage Quick Key 
Status

Favorites Quick Key Scroll to desired 
FLQK 
and press E to toggle 
it on/off

System Quick Key Scroll to the FL the 
systems are in and 
press E, then scroll to 
the system and press 
E to toggle the SQK 
on/off.

Set Nationwide 
Systems

Scroll to the desired nationwide system 
and press E to turn it on or off for scanning. 
Nationwide systems are similar to service 
searches used in older scanners. 

Select Lists to Monitor Scroll through the list and press E to toggle 
the item on/off for scanning. Note that this 
does not affect the FLQK status. If the item is 
set to No, it cannot be turned on for scanning 
using quick keys.

Set All Lists Off Sets all of the items in the above menu to Off.

Set All Lists On Sets all of the items in the above menu to On.

Manage Full 
Database

Review Avoids Scroll to entries in this list to see all items 
avoided in the main database. When selected, 
press E to remove the avoid status.

Stop All Avoiding Removes avoid status from the entire main 
database.

Information Displays the date the main database was last 
updated in the scanner.

Manage Favorites See Managing Favorites Lists on page 31
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Set Your Location Set Manual Location Input your Latitude and Longitude for precise 
radio system selection.

Set Up GPS Location Format Scroll to select the 
format for entering 
and displaying 
latitude and longitude

Set Serial Port Set the data rate to 
use with a connected 
GPS. The default 
of 4800bps is the 
standard data rate for 
most units.

Set Range Sets the range, in miles, the scanner should 
look out from the set location to determine 
which radio systems to scan.

Edit Location Scroll to select and edit a saved location. You 
can then select the appropriate menu item for 
what you want to change:
• Edit Name
• Use Location (sets your scanner to the 

stored settings)
• Delete Location
• Set Location Information (change the stored 

latitude and longitude)
• Set Range

Save Location Saves your current location settings for quick 
recall. First, set the name for the location, 
then select the menu items to set the location:
• Edit Name
• Use Location (sets your scanner to the 

stored settings)
• Delete Location
• Set Location Information (change the stored 

latitude and longitude)
• Set Range

Select Service Types The scanner displays a list of all service types. Scroll to a service 
type and press E to toggle that service type on or off. Note that if no 
channels in the currently scanned database or favorites list(s) include 
a particular service type, that service type will have --- displayed 
instead of on or off. You cannot set that service type.
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Srch/CloCall Opt Freq Avoids Stop All Avoiding Removes avoid status 
from all frequencies.

Rvw Search Avoids Scroll to view search 
avoids. Press E 
while on an avoided 
frequency to unavoid 
that frequency.

Broadcast Screen Set All Band On Turns on all broadcast 
screens

Set All Band Off Turns off all broadcast 
screens

Set Each Band Scroll through the list 
of broadcast screens 
and press E to turn a 
particular screen on 
or off. When a screen 
is turned on, the 
scanner 
will ignore any traffic 
found on a matching 
frequency during 
search or Close Call 
operation.

Program Band Scroll to an entry 
then enter the upper 
and lower limits of 
any frequency band 
you want to make a 
custom screen for.

Repeater Find On Automatically switch 
to repeater output 
side when input side 
is detected.

Off Do not switch to 
repeater output side.

Set Delay Time -10
-5
0
1
2
3
4
5
 .
 .
 .

Hold on the frequency 
the set amount of time 
after the transmission 
ends to wait for 
replies. Negative 
value forces search 
resume after set time, 
even if transmission 
continues.
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Set Attenuator On Apply 20dB 
attenuation to all 
reception.

Off Attenuation is off.

Search For… Custom Search Select Custom, then:

Edit Name Edit the name of the 
custom search

Edit Srch Limit Enter the upper 
and lower range 
frequencies.

Set Delay Time Set Delay Time
Set the delay after a 
transmission ends. 
See setting above for 
options.

Set Modulation Set the demodulation 
method to use for the 
range. AUTO uses 
default modes based 
on bands.

Set Attenuator Turn attenuation on or 
off for the search.

Set Step Set the step size for 
the search. AUTO 
uses standard steps 
based on the band 
being search.

Search with Scan Set Avoid option lets 
you stop avoiding 
(i.e. include the 
search during scan), 
temporarily avoid, or 
permanently avoid.
Set Hold Time option 
determines how long 
the scanner spend 
in the custom search 
before resuming 
normal scanning.

Edit Custom Select the custom search to edit, then select 
the setting(s) to change. Settings are identical 
to the Custom Search settings, above.

Set Search Key Select the Search 
key.

Then, set the function 
you want the search 
key to control.
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Search with Scan Set System Avoid Set to Temporary or 
Permanent to turn off 
search with scan.

Close Call Close Call Only Turn off scanning/searching and only watch 
for Close Call hits

Hits with Scan Set Avoid Set to Stop Avoiding 
to include Close Call 
hits while scanning.

Set Hold Time Set how long to scan 
Close Call hits during 
each scan cycle.

Set CC Mode Off Close Call is turned off

CC DND Scanner checks 
for Close Call hits 
only when no other 
voice traffic is being 
received.

CC Priority Scanner checks for 
Close Call hits every 
2 seconds, even if 
voice traffic is being 
received.

Set CC Alert Set Alert Tone Scroll to select the 
alert tone to sound 
when there is a Close 
Call hit. Then, scroll 
to select the volume 
level for the alert 
(Auto uses the current 
volume setting).

Set Alert Light Scroll to select 
the color the alert 
indicator lights when 
there is a Close Call 
hit. Then scroll to 
select a blink pattern 
for the alert.

Set CC Pause Scroll to select 
the color the alert 
indicator lights when 
there is a Close Call 
hit. Then scroll to 
select a blink pattern 
for the alert.

Set CC Bands Scroll to each band and press E to toggle 
Close Call checks for that band on or off.
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Analyze See Using Analyze Features on page 45

Discovery See Using Discovery Mode on page 43

Priority Scan Set Priority Off Conventional priority 
is turned off.

Priority DND Conventional priority 
be checked only when 
no other voice traffic 
is being received

Priority Scan Conventional priority 
will be checked on 
an interval, even if 
voice traffic is being 
received. Interval is 
set by setting, below.

Set Interval Select how often the scanner will check for 
traffic on conventional priority channels. 
Default is 2 seconds.

Max Channels / Pri 
Scan

Sets the maximum number of conventional 
priority channels to check on each interval. 
(1-100)

Tone-Out-For
(For USA only)

Tone-Out Standby Select this and the scanner will go into toneout 
standby mode. Scroll to select the toneout 
settings to use. If multiple settings use the 
same RF settings but different tone settings, 
all matching settings are used. No other 
function works while the scanner is in tone-out 
standby mode. (For USA only)

Tone-Out Setup Scroll to select the tone-out settings you want 
to edit, then use the below menu items to 
change settings: 

Edit Name Set the alpha tag for 
the tone-out settings

Set Frequency Set the RF frequency, 
Modulation, and 
Attenuation settings.

Set Tone Set the values for 
Tone A and Tone B. 
For a single short 
tone, only set Tone 
A. For a single long 
tone, only set Tone B. 
To search for tones 
leave both settings at 
0.
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Set Delay Time Select how long the 
scanner waits after 
the carrier drops to 
return to tone-out 
standby mode.

Set Alert Set the tone and 
indicator color/ 
pattern to use when 
a matching two-tone 
alert is received.

Display Options Backlight Options Set Mode Set how the display 
backlight behaves 
when squelch opens 
and/or when a key is 
pressed.

Set Dimmer Set the backlight 
brightness level 
(default 40%)

Set Key Backlight Enable: turns on/off w/ 
the display backlight; 
Disable: Always off.

Flash w/Backlight 
Off

Turn on to have the 
alert indicator blink 
every 5 seconds when 
the display backlight 
is off (so you can tell 
the scanner is on).

Customize See Customizing the Display on page 38

Set ID Format Select to display Motorola/P25 Talk Group IDs 
in Decimal or Hex format.

Set ID Format 
(EDCS)

Select to display EDACS Talk Group IDs in 
Decimal or Hex format.

Set B/W or Color 
Mode

Set the display color mode: Color for full color 
display, or Black w/White Text or White with 
Black text for black and white modes (which 
are easier to see under direct sunlight.
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Main Menu Sub Menu Setting or Sub-sub 
menu

Setting

Settings Adjust Key Beep Rotate to set the key beep volume. AUTO sets 
the level to match the current volume setting.

Set Clock Follow the menus to set the date, time, time 
zone, and daylight savings time.

Upgrade Use to enter a registration key for upgrade 
options.

Battery Options Set Battery Save Turn on to reduce 
power use during 
conventional hold 
mode.

Set Battery Low Follow the menus to 
set the battery alert 
display type and tone 
and the low-battery 
voltage.

Band Defaults Select a frequency band then follow the menu 
to set the default modulation and step for each 
band.

Auto Shutoff Select how long the scanner will operate 
before automatically turning off. Set to off to 
disable this function.

Replay Options Set Replay Duration Set how much audio 
is included in the 
replay buffer.

Review Recordings Scroll to a recording 
session and select 
to play, delete, or 
rename a recording 
session.

Restore Options Clear User Data Delete all Favorites 
Lists and user 
settings.

Reset User Settings Clear user settings w/
o affecting Favorites 
Lists.

See Scanner 
Information.

% Memory Used Displays the 
remaining 
capacity of the 
microSD card.

Firmware Version Displays the firmware 
version and Electronic 
Serial number of the 
scanner.
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MANAGING FAVORITES LISTS

Favorites Lists hold all your custom Systems, Sites, Departments, and Channels. Certain system, 
department, and channel options are only available for specific types of systems. Each option is 
tagged with the type(s) it applies to as follows:

•  P – APCO Project 25
•  M – Motorola
•  D – DMR (Optional mode)
•  N – NXDN (Optional mode)
•  E – EDACS
•  L – LTR
•  C – Conventional

NEW FAVORITES LIST/ FAVORITES LIST OPTIONS

Press Menu then scroll to Manage Favorites and press E/yes.
To Create a New Favorites List, scroll to New Favorites List and press E/yes. To Edit a Favorites 
List, scroll to the Favorites List and press E/yes.
Scroll to the options below and press E/yes.
Review/Edit System – See Programming Systems.
Set FL Quick Key – This assigns a quick key to the Favorites List. The default setting is. (no 
quick key). If you don’t assign a Favorite Lists to a quick key, it will always be scanned unless you 
turn it off in Select Lists to Monitor.
Scroll to the quick key (0-99 or . for no quick key) and press E/yes to save.

Pressing the first number of a 2-digit quick key will get you closer, 1 for 10, 2 for 20, etc., 
then scroll to second digit.

Set FL Number Tag – Numbers a Favorites List so you can access it quickly from scan hold 
mode.
The default setting is no number tag.
Enter the number tag (0-99) and press E/yes to save. Enter a blank for no number tag.
Set FL Startup Key – This allows you to turn on the scanner with the Favorites List enabled for 
scan. The default settings are all keys Off.
Scroll to the startup key (0-9) and press E/yes to enable then Menu to save.
Use Location Control – This enables Location Control for the Favorites List. The default setting 
is Off. 
Review Avoids – This allows you to review all Avoids for the Favorites List. Temporary Avoids 
appear reversed in the display - AVOID. 
Scroll to each Avoided channel, Department, or System, and press E/yes to Stop Avoiding. 
Stop All Avoiding – This will Stop Avoiding all Channels, Departments, and Systems in the 
Favorites List.
At Confirm Delete? Press E/yes or ./no.
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Add Current dB Channels – This allows you to add all channels you are currently scanning to 
the Favorites List.
At Confirm? Press E/yes or ./no.

Notes:

• Any Avoided Channel will not be added.
• When adding channels from the Full Database, only channels that are inside the set range, 

and from the selected Service Types are added.
• When adding channels from a Favorites List that has Use Location Control is set to Yes, only 

channels that are inside the set range, and from the selected service types are added.
• When adding channels from a Favorites List that has Use Location Control set to No, only 

channels that are from the selected service types are added.

Rename – This allows you to rename the Favorites List.
Delete – This will delete the Favorites List.
At Confirm Delete? Press E/yes or ./no.
Information – This will show you the file size and number of Systems in the list.

PROGRAMMING SYSTEMS

CREATING OR EDITING A SYSTEM

1. Press Menu then scroll to Manage Favorites and press E/yes. Scroll to the Favorites List 
you want the system to go into, then press E/yes.

2. Scroll to Review/Edit System and press E/yes.
3. To Create a New System, scroll to New System and press E/yes.
Set the type system you are creating by scrolling to P25 Trunk, P25 X2-TDMA, P25 One 
Frequency, Motorola, MotoTRBO Trunk (optional), DMR One Frequency (optional), NXDN Trunk 
(optional), NXDN One Frequency (optional), EDACS, LTR, or Conventional and press E/yes. At 
Confirm? press E/yes or ./no.

To Edit System Settings, scroll to the System and press E/yes.
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SYSTEM SETTINGS

Some settings are only available for specific types of systems.
MotoTRBO, DMR and NXDN modes are optional upgrades.

Edit Name – Enter a name for the system then press E/yes.
Edit Sys Option – Refer to the following table for system options settings.

Setting Description Applicable Systems

Set System Quick Key Sets a quick key to enable/disable 
the system

PMDNELC

Set System Number Tag Sets a tag to quickly jump to the 
system.

PMDNELC

Set Avoid Set the avoid status for the system PMDNELC

Set Hold Time How long to scan the system before 
moving to the next system. Default 
of 0 scans entire system once, then 
moves on.

PMDNELC

ID Search Toggles between ID Search mode 
(stop on all unavoided channels) and 
ID Scan (stop only on programmed 
channels) mode. 

PMDNEL

Edit Fleet Map Sets the fleet map for the system. M

Priority ID Scan Sets the system to apply trunked 
channel priority for the system.

PMDNEL

Set Status Bit Sets whether to ignore the talk group 
status bit (default is ignore).

M

Set End Code Set whether to ignore the end code 
sent when a radio unkeys (default is 
to not ignore). 

M

Emergency Alert Sets the alert sound and alert 
indicator when the scanner receives 
an emergency status from the 
system.

MDNE

Set TGID Format Sets the format used to enter/display 
talk group IDs.

N

Review ID Avoids Lets you review and remove avoids 
from talk group IDS

PMDEL

Clear all ID Avoids Removes avoid status for all system 
talk groups.

PMDNEL

Digital Waiting Time Sets how long the scanner monitors 
a channel for digital signals before 
opening squelch. Default is 400 mS.

M

Edit Site PMDNEL – Programs one or more site’s frequencies and site options for trunked 
systems. Select the site or New Site for a new site, then refer to the following table for site options.
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Option Description Applicable Systems

Edit Name Set/change the name displayed for 
the site.

PMDNEL

Set Site Quick Key Set the quick key for the site. PMDNEL

Edit Band Plan Set the band plan to be used for the 
system

M

Set Site Type Set whether the site is Wide or 
Narrow type.

E

Set Frequencies Set the frequencies used by the site. 
For system types that also require 
an LCN, the LCN is also entered 
here.

PMDNEL

Set Modulation Set what modulation method is used 
for the site frequencies.

MDNEL

Set Attenuator Set whether attenuation is applied 
for the site.

PMDNEL

Set Avoid Set the avoid status for the site. PMDNEL

Set Location Information Select whether to use a circle 
or rectangles to define the site 
location, then enter the appropriate 
parameters to define the site 
location.

PMDNEL

Delete Site Delete the site from the system. PMDNEL

New Site Create a new site for the system. PMDNEL

Edit Department – Create/Edit departments which hold the channels scanned on the system. 
Select a department or select New Department and set a name for the department. Then, see the 
following table for department options.

Setting Description Applicable Systems

Edit Name Edit the name displayed when the 
department is scanned.

PMDNELC

Set Department Quick Key Set/change the quick key used for 
the department

PMDNELC

Edit Channel Enter the TGIDs or Frequencies 
for the department. See Channel 
Options, below

PMDNELC

Set Location Information Select whether to use a circle or 
rectangles to define the department 
location, then enter the appropriate 
parameters to define the department 
location.

PMDNELC
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Setting Description Applicable Systems

Set Avoid Set/change the avoid status for the 
department

PMDNELC

Delete Department Delete the department and all its 
channels

PMDNELC

New Department Create a new department PMDNELC

Channel Options

After you enter the Talk Group ID (for trunked systems) or frequency (for conventional systems, 
the following channel options are available.

Setting Description Applicable Systems

Set Name Assign a name that is displayed for 
the channel while scanning

PMDNELC

Edit TGID Edit the talk group ID set for the 
channel

PMDNEL

Set TDMA Slot Set the slot used by the channel. D

Edit Frequency Edit the frequency used by the 
channel.

C

Set Audio Type Set whether the channel is analog or 
digital.

MEC

Set Channel Number Tag Assign a channel number tag for 
quick channel navigation.

PMDNELC

Set Modulation Set the modulation method used for 
the channel

C

Set Attenuation Set whether the channel is RF 
attenuated

C

Set Service Type Set the service tag for the channel. PMDNELC

Set Delay Time Set how long the scanner holds on 
the channel after a transmission 
stops while waiting for a reply. 
Default is 2 seconds.

PMDNELC

Set Priority Set whether the channel is a priority 
channel.

PMDNELC

Set Alert Set the audio/indicator alert to use 
when the channel becomes active.

PMDNELC

Set Avoid Set whether the channel is avoided 
or not.

PMDNELC

Volume Offset Set a volume offset for the channel. PMDNELC

Delete Channel Delete the channel. PMDNELC

New Channel Create a new channel. PMDNELC
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Edit Unit ID PMDE – Unit ID must be set to On in the Display Options menu to view Unit IDs. 
Select a Unit ID or New Unit ID, then press E/yes.

If you selected New Unit ID, enter the Unit ID and press E/yes. Then, set the following 
options.
Edit Name – Set the name to be displayed for the Unit ID.
Edit Unit ID – Edit the Unit ID Number.
Set Alert – Set an alert that will activate when the Unit ID is received.
Set Alert Tone – Alert 1-9 or Off.
Set Level – 1-15 or Auto (the master volume level).
Set Alert Light – Off, Blue, Red, Magenta, Green, Cyan, Yellow, or White. 
Set Alert Pattern – On, Slow Blink, or Fast Blink.
Delete Unit ID – At Confirm Delete?, press E/yes or ./no.

Copy System – Copying a system will copy all Sites, Departments, Channels, and settings 
including quick key assignments into the current Favorites List.
Delete System – At Confirm Delete?, press E/yes or ./no.
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CUSTOMIZING THE DISPLAY

The SDS100E gives you considerable control over what items are shown on the display as well 
as what colors are used for each item.
To customize the display, select MENU → Display Options → Customize then select the display 
you want to customize:

• Set Simple Conventional
• Set Simple Trunk
• Set Detail Conventional
• Set Detail Trunk
• Set Search/CC Mode
• Set Weather Mode
• Set Tone Out Mode

Notes: 

• During scan you can switch between Simple and Detail display modes by holding on a 
channel and pressing F+DISP.

• Some display modes or display fields only allow you to change the colors.
• Trunking/Conventional modes share the same display field colors, but each scan mode can 

display different data items.
• Every possible data item cannot fit into all the different display fields.

After selecting the display mode to customize, the scanner displays a sample display in the mode 
you selected. Rotate the scroll to highlight the area you want to modify, then press the appropriate 
soft key for the attribute you want to change:

• Item: Change the item displayed in the field.
• T-Color: Change the text color for the field.
• B-Color: Change the background color for the field

When you select one of the above, the display will switch to showing the available options. Select 
the option to use, then press E to return to the sample display.
The customizable fields are shown in the following images. Note that the areas shaded darker 
in these images can only have text/background color changed. The displayed item cannot be 
changed.
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SIMPLE DISPLAY MODE

Conventional and Trunked mode share the same color scheme, but different display items are 
available for each mode.

DETAIL DISPLAY MODE
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SEARCH/TONE-OUT/WEATHER MODE

You can individually set colors for Search/Close Call mode, Weather Mode (For USA only), and 
Tone-Out mode (For USA only), but they share the same general layout. You can only set display 
option items for Search mode.

AVAILABLE ITEMS

The below tables outline what display items are available. Note that not all items are possible for 
all display fields.

Item Sample Huge 22 Large 
16/14

Short 
5 Char

Favorites List Name  O O -

Site Name  O O -

Unit ID Name  O O -

Frequency xxxx.xxxxMHz O O -

TGID TGID:xxxxxxxx O O -

RSSI RSSI:x.xxV - O -

System type DMR One Frequency O O -

System/Network ID Net ID : xxxx O O -

 Sys ID : xxxx
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Item Sample Huge 22 Large 
16/14

Short 
5 Char

Site ID Site ID : xxxx O O -

Unit ID UID : 12345678 O O -

LCN LCN:4096 O -

Number Tag Tag:FF-SS-CC O O -

Volume/Squelch VOL=15 SQL=15 O O -

Volume V:15 - - O

Squelch S:15 - - O

Battery voltage Batt:x.xxV O -

Digital Error count Err:xx O -

ATT G-ATT - - O

P25 Status P25-2 - - O

Day mm/dd - - O

Time xx:xx - - O

Modulation NFM - - O

Icon Area

Item Sample

Priority Scan PRI

Close Call CC (icon)

WX PRI WX

REC REC

GPS GPS

Broadcast Screen SCR

Repeater Find REF

Volume Offset V+x

Modulation NFM

P-Ch P
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USING DISCOVERY MODE

Trunking Discovery mode allows you to monitor a trunked radio system, logging system activity 
and recording the audio for channel identification.
Conventional Discovery mode lets you monitor a range of frequencies, logging frequencies with 
activity and recording the audio for frequencies that are not already known to be in use in your 
area so that you can more easily identify the users. This includes frequencies used conventionally 
as well as in trunked radio systems.
In both modes, you also have the option to compare hits to the Database and log all hits or just 
new hits.
If you use the Auto Store option, Discovery will create a new Trunking System for IDs found for 
each Session or will create a new Conventional System for frequencies found for each Session.
You can create and save several sessions with different settings. Every time you start a session 
you create a Run that can later be reviewed in the scanner or the Sentinel software.

RUNNING A DISCOVERY SESSION

To start a discovery session:

Press MENU → Discovery then select either Trunking Discovery or Conventional Discovery.

Select either New Session or an existing session. If you select New Session, you will be prompted 
to name the session.
If you selected Trunking Discovery and this is a new session, you will be prompted to select the 
trunked system and site to perform discovery on. In order to run trunking discovery, the trunked 
system and site must be available for scanning (i.e. in and active Favorites List or within the 
defined location of the Main Database). Select the system and the site.
Refer to the following table for Discover options.

Menu Item Description

Start Discovery Start a discovery session using the currently set parameters.

Edit Session Name Edit the name of the selected session.

Set Limit Frequencies (Conventional Discovery Only) Set the upper and lower limits of 
the frequency range you want to run discovery on.

Set Modulation (Conventional Discovery Only) Set the demodulation method 
to use. If set to AUTO (default), the scanner will use the default 
demodulation method for the frequency.

Set Step (Conventional Discovery Only) Set the frequency step size for 
the session. If set to AUTO (default), the scanner uses the default 
frequency step for the frequency.

Set Delay Sets how long the scanner pauses after a transmission waiting for 
a reply.
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Menu Item Description

Set Logging ALL for all hits; NEW for only items that are not yet discovered in 
this session.

Set Compare to Database On compares hits to database and ignores the hit if it is already in 
the database. Off records all hits.

Set Record Duration Sets how much audio the scanner records for each hit. Once 
the record duration has been met, the frequency or TGID is 
considered “discovered.”

Set Time-Out Timer Sets how long the scanner will monitor a hit before resuming scan 
automatically. This prevents open carriers from locking up the 
discovery session.

System Information (Trunking Only) Displays the Favorites List, system and site used, 
as well as the type of trunking system.

Set Auto Store When on, creates a Favorites List called Conventional Discovery 
or Trunking Discovery and saves all hits as channels.

Delete Session Deletes the discovery session, including all hits.

REVIEWING A DISCOVERY SESSION

In Review Discovery mode, you can review the results of discovery mode runs, resume runs, or 
restart saved discovery sessions.

1. Press Menu → Discovery → Review Discovery
2. Select either Trunk Discovery Results or Conventional Discovery Results.
3. Scroll to select the results to review.

Refer to the following table for review options:

Option Description

Review Run Results Select Summary to list be each frequency or talk group id; select 
Detail to list by each individual hit.

Restart this Run Deletes existing log files for this session and starts a new session 
with the same settings.

Resume this Run Keeps existing log files and resumes the session.

Delete this Run Deletes the run and all log files for the run.

Run Information Displays information about the settings used for the discovery 
session.
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USING ANALYZE FEATURES

The SDS100E includes some analysis features that can help you find out more information about 
systems you are scanning.

SYSTEM STATUS

This function displays the signal strength, decode quality, and how busy the system is in an easy 
to decipher display.
To uses this function:

MENU → Analyze → System Status

The scanner prompts for a trunked system to analyze. In order to be analyzed, the system must 
currently be scannable (in an active Favorites List or Main Database and within the range set for 
scanning).
Enter the first few letters of the system name, then press E to see a list of all matching systems. 
Scroll to the desired system, then press E. A list of scannable sites for the system is shown. Scroll 
to the desired site, then press E. System Status mode starts.
• S=Signal Strength
• Q=Decode Quality
• A=System Activity

LCN FINDER

LCN Finder helps you determine the correct LCN (Logical Channel Number) settings for those 
systems requiring LCN entry. You first need to create the system. Use any number as the LCN 
when you create the system, then run the LCN Finder by: MENU → Analyze → LCN Finder  
The scanner prompts for a trunked system. For LCN Finder to run, the system must currently be 
scannable (in an active Favorites List or Main Database and within the range set for scanning), 
and must be a type that requires LCN (EDACS, LTR, MotoTRBO, DMR TIII, NXDN).
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Enter the first few letters of the system name, then press E to see a list of all matching systems. 
Scroll to the desired system, then press E. A list of scannable sites for the system is shown. Scroll 
to the desired site, then press E. LCN Finder mode starts.
Once all LCNs are found, you can save the LCNs to the system. If you abort before all LCNs are 
found, you can still save the LCNs that were found up to that point.
Note that LCN finder works best on systems with moderate activity. Too much traffic or too little 
traffic make LCN finder take longer to complete for most systems.

APPENDIX

TROUBLESHOOTING

Problem Solution

Scan Mode, Nothing to 
Scan

• Make sure you Set Your Location to scan the Database.
• Make sure Favorites Lists are enabled in Set Scan 

Selection.
• Make sure Service Types are enabled for the Channels you 

want to hear.
• Make sure you have locations programed if Use Location 

Control is On.
• Make sure longitude and latitude are N and W (for N 

America).
• Make sure Systems/Departments/Channels are not 

Avoided.
• Make sure Favorites List/System/Department/Site quick key 

is enabled.
• (Search with Scan) Make sure Search with Scan is enabled 

in Select Lists to Monitor and the Search for Menu and for 
the Custom Search.

Scanning Interrupted Every 
Few Seconds

• Turn off Priority Scan.
• Change Priority Interval.
• Turn off Close Call Priority.
• Turn off Weather Priority.
• Set Channel Delay longer.
• Set positive Channel Delay.

All Channels Out of Range • Increase your range.
• Change your location.
• Turn Location Control off for the Favorites List.
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DEFAULT BAND SETTINGS

Frequency Range Mode Step (kHz)
25.0000 29.9950 FM 5K

30.0000 53.9875 FM 12.5K

54.0000 75.9875 FM 12.5K

76.0000 79.9875 FM 12.5K

80.0000 82.9900 FM 10K

83.0000 83.9875 FM 12.5K

84.0000 87.9875 FM 12.5K

87.3000 87.9500 FMB 50K

88.0000 107.9500 FMB 50K

108.0000 136.9916 AM 8.33K

137.0000 137.9950 FM 5K

138.0000 143.9875 FM 12.5K

144.0000 145.9875 FM 12.5K

146.0000 155.9875 FM 12.5K

156.0000 157.9875 FM 12.5K

158.0000 160.5900 FM 10K

160.6000 162.0125 FM 12.5K

162.0250 162.5875 FM 12.5K

162.6000 173.9900 FM 10K

174.0000 215.9500 WFM 50K

216.0000 224.9950 FM 5K

225.0000 399.9750 AM 25K

400.0000 405.9875 FM 12.5K

406.0000 439.99375 FM 6.25K

440.0000 440.9950 FM 5K

450.0000 465.9950 FM 5K

466.0000 469.9900 FM 10K

470.0000 512.0000 FM 6.25K

806.0000 893.9875 FM 12.5K

894.0000 960.0000 FM 12.5K

1240.0000 1300.0000 FM 12.5K

• When you select AUTO for a channel or modes modulation or step, the above values are 
used unless you’ve edited the Band Defaults.

• Steps can be selected from 5/6.25/7.5/8.33/10/12.5/15/20/25/50/100/AUTO (kHz).
• Although TV bands are listed, the scanner cannot decode digital TV audio.
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SERVICE TYPES

Service Type Description
Aircraft For civilian aircraft and air traffic control operations most typically in 

the 118-136 MHz and 225-380 MHz bands in AM mode.

Business Most business related entities not covered by other tags.

Corrections Jail/prison operations, corrections activities, federal prisons.

Emergency Ops Emergency Operation Centers and similar emergency management 
or disaster related operations.

EMS Dispatch Ambulance dispatch, including rescue squads.

EMS-Tac Ambulance on-scene communications, tactical operations and 
secondary channels.

EMS-Talk Ambulance talk-around, car-to-car and supervisor operations.

Federal All federal government operations (except corrections, traditional law 
enforcement patrol and fire/EMS operations).

Fire Dispatch Fire dispatch, including combined fire/ambulance dispatch.

Fire-Tac Fireground, tactical and on-scene communications, including 
combined fire/ambulance operations.

Fire-Talk Fire talk-around and car-to-car operations, chiefs, supervisors, etc., 
including combined fire/ambulance operations.

Ham Any amateur radio assignment.

Hospital Ambulance-to-Hospital communications and patient reports.

Interop Interoperability communications, cross-agency communications, 
mutual aid, etc.

Law Dispatch Law enforcement dispatch.

Law-Tac Law enforcement tactical, SWAT, on-scene, surveillance and specific 
sub-agency communications.

Law Talk Law enforcement talk-around, car-to-car and supervisor operations.

Media Newspapers, television and broadcast radio operations.

Military Military operations, e.g., range control, air-to-air combat, etc.

Multi-Dispatch Combined law enforcement and fire/ambulance dispatch.

Multi-Tac Combined law enforcement and fire/ambulance tactical and onscene 
communications.

Multi-Talk Combined law enforcement and fire/ambulance tactical talk-around 
and car-to-car operations.

Public Works Public agency non-public safety communications. This includes any 
nonpublic safety government services, such as trash, streets, roads, 
sewer, zoos, administration, maintenance, animal control, community 
initiatives, code compliance, etc.

Race Officials Available for use to identify officials’ frequencies for racing events.

Race Teams Available for use to identify team frequencies for racing events.

Railroad All common carrier railroad communications.
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Service Type Description
Schools School-related communications (schools, school buses, football 

games, etc.).

Security Non-law enforcement security operations, including private security 
companies, noncommissioned government agency security, school 
security, etc.

Transportation Public and private bus, taxi, and public passenger rail 
communications.

Utilities Private electric, water, natural gas, phone, cable TV, etc. operations.

Custom 1-8 User-defined service types.

REMOVING THE MICRO SD CARD

Carefully remove the SD Card by removing the back cover, then removing the battery pack. 
Slightly press down and slide the SD card holder right, then lift out the card. Gently install the SD 
Card the same way it was removed.

REFORMATTING THE MICRO SD CARD

SD cards should only be formatted using the special SD Card Formatter (https://www.sdcard.org/ 
downloads/formatter_4/). Then, you need to “Clear User Data” using Sentinel to restore all files 
and directories to the card.
After formatting, the scanner won’t be automatically detected (since it is wiped clean), so you may 
need to uncheck “Hide empty drives” in Windows Tools>Folder Options>View before doing the 
“Clear User Data” step.

TYPE II SPECIAL STATUS BITS

Type II Motorola Smartnet systems use these status bits for special transmissions such as 
emergency, patches, DES/DVP scrambled transmissions, and multiselects. Motorola trunking 
radios directly interpret them for their special functions, thus no difference is noticed by the 
person with the radio. The scanner however interprets these special talk group status bits as 
different talk groups entirely. Below is the conversion chart for these special status bits.

TT ID + # Usage TT ID + # Usage
ID+0 Normal Talk group ID+8 DES/DVP Encryption talk group

ID+1 All Talk group ID+9 DES All Talk group

ID+2 Emergency ID+10 DES Emergency

ID+3 Talk group patch to another ID+11 DES Talk group patch

ID+4 Emergency Patch ID+12 DES Emergency Patch

ID+5 Emergency multi-group ID+13 DES Emergency multi-group

ID+6 unassigned ID+14 unassigned

ID+7 Multi-select (initiated by dispatcher) ID+15 Multi-select DES TG
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Therefore, if a user was transmitting a multi-select call on talk group 1808, the scanner would 
actually receive those transmissions on 1815.  
Some common uses of these status bits are as follows:

• When a user hits their emergency button, all conversations on the talk group revert to 
the emergency status talk group (ID+2) until the dispatch clears the emergency status. 
Therefore, if someone hit their emergency button and their radio was on talk group 16, all 
communications would switch to talk group 18.

• A lot of Fire and EMS departments dispatch tone-outs and alarms as Multi-select 
communications (ID+7). Therefore, if your fire department dispatch talk group is 1616, and 
they do dispatch tone-outs and alarms as Multi-selects, then those communications will be 
on talk group 1623.

CTCSS FREQUENCIES

The scanner can detect the following 50 CTCSS frequencies.

67.0Hz 94.8Hz 131.8Hz 171.3Hz 203.5Hz

69.3Hz 97.4Hz 136.5Hz 173.8Hz 206.5Hz

71.9Hz 100.0Hz 141.3Hz 177.3Hz 210.7Hz

74.4Hz 103.5Hz 146.2Hz 179.9Hz 218.1Hz

77.0Hz 107.2Hz 151.4Hz 183.5Hz 225.7Hz

79.7Hz 110.9Hz 156.7Hz 186.2Hz 229.1Hz

82.5Hz 114.8Hz 159.8Hz 189.9Hz 233.6Hz

85.4Hz 118.8Hz 162.2Hz 192.8Hz 241.8Hz

88.5Hz 123.0Hz 165.5Hz 196.6Hz 250.3Hz

91.5Hz 127.3Hz 167.9Hz 199.5Hz 254.1Hz

DCS CODES 

The scanner can detect the following 104 hexadecimal DCS codes.

006 031 054 116 145 205 245 266 332 411 452 506 612 703

007 032 065 122 152 212 246 271 343 412 454 516 624 712

015 036 071 125 155 214 251 274 346 413 455 523 627 723

017 043 072 131 156 223 252 306 351 423 462 526 631 731

021 047 073 132 162 225 255 311 356 431 464 532 632 732

023 050 074 134 165 226 261 315 364 432 465 546 654 734

025 051 114 141 172 243 263 325 365 445 466 565 662 743

026 053 115 143 174 244 265 331 371 446 503 606 664 754
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REVERSE LIST

Range (MHz) Offset (MHz) Range (MHz) Offset (MHz)
29.5200 - 29.5800 + 0.1 450.0000 - 454.9875 + 5

29.6200 - 29.6800 - 0.1 455.0000 - 459.9875 - 5

52.0100 - 52.9900 + 1 460.0000 - 464.9875 + 5

53.0100 - 53.9900 - 1 465.0000 - 469.9875 - 5

143.7500 + 4.375 470.0000 - 472.9875 + 3

143.9000 + 4.25 473.0000 - 475.9875 - 3

144.5100 - 144.8900 + 0.6 476.0000 - 478.9875 + 3

145.1100 - 145.4900 - 0.6 479.0000 - 481.9875 - 3

146.0100 - 146.3850 + 0.6 482.0000 - 484.9875 + 3

146.4150 - 146.5050 + 1 485.0000 - 487.9875 - 3

146.5950 + 1 488.0000 - 490.9875 + 3

146.6100 - 146.9850 - 0.6 491.0000 - 493.9875 - 3

147.0000 - 147.3900 + 0.6 494.0000 - 496.9875 + 3

147.4150 - 147.5050 - 1 497.0000 - 499.9875 - 3

147.5950 - 1 500.0000 - 502.9875 + 3

147.6000 - 147.9900 - 0.6 503.0000 - 505.9875 - 3

148.1250 - 4.375 506.0000 - 508.9875 + 3

148.1500 - 4.25 509.0000 - 511.9875 - 3

222.1200 - 223.3800 + 1.6 758.0000 - 775.9937 +30

223.7200 - 224.9800 - 1.6 788.0000 - 805.9937 -30

420.0000 - 424.9875 + 5 806.0000 - 823.9875 + 45

425.0000 - 429.9875 - 5 851.0000 - 868.9875 - 45

440.0000 - 444.9875 + 5 896.0000 - 901.0000 + 39

445.0000 - 449.9875 - 5 935.0000 - 940.0000 - 39

REPEATER FREQUENCY LIST

Base Frequency 
(MHz)

Offset (MHz) Base Frequency 
(MHz)

Offset (MHz)

455.0151 - 459.9950 - 5 497.0001 - 500.0000 - 3

465.0101 - 469.9950 - 5 503.0001 - 506.0000 - 3

473.0001 - 476.0000 - 3 509.0001 - 512.0000 - 3

479.0001 - 482.0000 - 3 758.0000 - 775.9937 +30

485.0001 - 488.0000 - 3 806.0051 - 823.9875 +45

491.0001 - 494.0000 - 3 894.0125 - 921.0000 +39
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TECHNICAL SPECIFICATIONS

1. Band Coverage  : 31 Bands

2. Memory System  : No programming required 
Preset Program
Factory programmed to microSD card for all known radio systems 
in USA and Canada

3. Step Size  : 5/ 6.25/ 7.5/ 8.33/ 10/ 12.5/ 15/ 20/ 25/ 50/ 100/ AUTO kHz
(User-programmable)

4. GPS Function  : (with Option Cable BC-UTGC(UU-710Z))
The formats of the GPS data, which the scanner can receive are only
GGA (Global Positioning System Fix Data) and 
RMC (Recommended Minimum Specific GNSS Data) 
based on “NMEA-0183 ver.3.01”.

* The GPS Unit for a valuation basis is as follows.
• GARMIN eTreX
• GARMIN Rino110
• GARMIN GPS18PC
• Lowrance iFinder GO2
• MAGELLAN Meridian Marine

5. Two-Tone-Sequential  : 250.0 ~ 3500.0Hz , 0.1Hz Step Programmable

6. WX Alert  : 1050Hz Tone System
NWR-SAME System (WARNING / WATCH / STATEMENT)

7. Trunking System  : Motorola System (Type Ⅰ , Ⅱ , Ⅱ i, X2-TDMA)
EDACS System (FM/NFM/ProVoice (optional))
LTR System
APCO System (ASTRO IMBE , ASTRO 25,P25
AMBE(HDQPSK))
DMR System (optional – MotoTRBO, Tier III)
NXDN System (optional – Nexedge, IDAS)

8. Remote Function  : Direct PC Control(USB2) 

9. Display : 2.4 inch LCD 240W*(RGB)*320H Dots

10. LED Indications  : ALERT (Multi Color)
CHARGE (Red ,Green) 

11. Backlight  : LCD  : White Color
Keys : White Color

12. External Jacks  : ANT. Jack : SMA Type
Phone Jack  : 3.5φ(Stereo Type)
                         32 ohm for Stereo-Headphone
                         64 ohm for Earphone
USB1 Jack  : 5pin micro USB 
USB2 Jack with Charge  : 5pin Mini USB 
Memory Card Slot  : microSD Type
Battery Jack  : 4pin for Li-ion Battery 

13. Internal Speaker  : 8 ohm, 1 W Max.(32φ)
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14. Power Requirements  : 3.7V Li-ion Polymer Battery
5.0V USB

15. Batt.Low Indication  : Beep Tone with 15 seconds interval & display on LCD

16. Operating Temp.  : -10℃ ~ +40℃
17. Charge Temp.  : +10℃ ~ +35℃
18. Storage Temp.  : -20℃ ~ +60℃
19. Clock Backup Time  : 1 week MIN (+25℃ / After over 50 hours of charge.)

20. Size (mm)  : 65(W) x 50(D)x 167(H) (W/O ANTENNA)

21. Weight  : 337g (With ANTENNA and BATTERY)

22. Accessories  : 3.7V Li-ion Polymer Battery Pack 
Rubber Antenna (SMA Type) 
SMA-BNC Transfer Connector
USB Cable
Belt Clip
micro SD CARD(SDHC)
AC Adaptor (5V DC OUTPUT)

23. Heterodyne System  :

 1st Heterodyne
 25.000 ~ 319.995 MHz : Upper Heterodyne   1st IF 265.55 MHz or 380.75 MHz
 320.000 ~ 512 MHz  : Upper Heterodyne   1st IF 265.55 MHz or 380.75 MHz
 806.000 ~ 1300.000 MHz	 : Lower Heterodyne   1st IF 265.55 MHz or 380.75 MHz
 2nd Heterodyne
 25.000 ~ 319.995 MHz : Lower Heterodyne   2nd IF 2.4 MHz
 320.000 ~  512.000 MHz : Upper Heterodyne   2nd IF 2.4 MHz
 806.000 ~ 1300.000 MHz : Lower Heterodyne   2nd IF 2.4 MHz

24. Filter  : 380.75MHz : SAW Filter 1st IF
265.55MHz : SAW Filter 1st IF

25. Other Condition  : IS4/IPX4 Structure

MEASUREMENT CONDITIONS

Power Source		 : 3.8V DC at Battery Terminal

Antenna Impedance  : 50 ohm

Test Temperature  : +25 ±5℃
Modulation Frequency  : 1kHz

Deviation  : FM ±3kHz  Dev. (CTCSS/DCS : 0.5 kHz Dev.)
NFM ±1.5kHz  Dev. (CTCSS/DCS : 0.35kHz Dev.)
AM 60% Modulation
FMB ±45.0kHz Dev.
WFM ±22.5kHz Dev. 

Mean Signal Input Level  : 1mV

Audio Output Load  : 32 Ω Resistive Load at Phone Jack

Standard Ref. Audio Output  : VOL 12
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Sensitivity  (12dB SINAD)

ITEM UNIT NOMINAL LIMIT
VHF Low 1 Band (AM) 25.005 MHz μV 0.7 1.6 Max

(NFM) 40.840 MHz μV 0.35 1.2 Max

(NFM) 53.980 MHz μV 0.3 1.2 Max

VHF Low 2 Band (WFM) 54.050 MHz μV 0.5 3.0 Max

(FM) 72.515 MHz μV 0.25 0.8 Max

(FMB) 107.500 MHz μV 0.8 2.0 Max

Aircraft Band (AM) 118.800 MHz μV 0.7 1.6 Max

(AM) 127.175 MHz μV 0.7 1.6 Max

(AM) 135.500 MHz μV 0.6 1.6 Max

VHF High 1 Band (NFM) 138.150 MHz μV 0.6 1.2 Max

(NFM) 161.985 MHz μV 0.35 1.2 Max

(NFM) 173.225 MHz μV 0.35 1.2 Max

(WFM) 197.450 MHz μV 0.6 3.0 Max

(NFM) 216.020 MHz μV 0.35 1.2 Max

VHF High 2 Band (AM) 225.050 MHz μV 0.7 1.6 Max

(AM) 272.950 MHz μV 0.7 1.6 Max

(AM) 315.050 MHz μV 0.7 1.6 Max

UHF Band (AM) 325.050 MHz μV 0.5 1.6 Max

(NFM) 406.875 MHz μV 0.35 1.2 Max

(NFM) 511.9125MHz μV 0.35 1.2 Max

Public Svc (NFM) 806.100 MHz μV 0.45 1.6 Max

(NFM) 857.150 MHz μV 0.4 1.6 Max

(NFM) 954.9125MHz μV 0.5 1.6 Max

1200MHz Band (NFM) 1299.925 MHz μV 1.0 2.0 Max
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Threshold Squelch (Manual)

ITEM UNIT NOMINAL LIMIT
VHF Low 1 Band (AM) 25.005 MHz μV 0.3 1.6 Max

(NFM) 40.840 MHz μV 0.2 1.2 Max

VHF Low 2 Band (WFM) 54.050 MHz μV 0.8 2.0 Max

(FM) 72.515 MHz μV 0.2 0.8 Max

(FMB) 107.500 MHz μV 0.8 2.0 Max

Aircraft Band (AM) 127.175 MHz μV 0.3 1.6 Max

VHF High 1 Band (NFM) 161.985 MHz μV 0.2 1.2 Max

(NFM) 173.225 MHz μV 0.2 1.2 Max

(WFM) 197.450 MHz μV 0.8 2.0 Max

VHF High 2 Band (AM) 272.950 MHz μV 0.3 1.6 Max

UHF Band (AM) 325.050 MHz μV 0.3 1.6 Max

(NFM) 406.875 MHz μV 0.2 1.6 Max

Public Svc (NFM) 857.150 MHz μV 0.3 1.6 Max

1200MHz Band (NFM) 1299.925 MHz μV 0.3 2.0 Max

Tight Squelch (Manual) (S+N)/N

ITEM UNIT NOMINAL LIMIT
VHF Low 1 Band (AM) 25.005 MHz dB 8 5 Min

(NFM) 40.840 MHz dB 8 5 Min

VHF Low 2 Band (WFM) 54.050 MHz dB 42 15 Min

(FM) 72.515 MHz dB 15 8 Min

(FMB) 107.500 MHz dB 48 15 Min

Aircraft Band (AM) 127.175 MHz dB 8 5 Min

VHF High 1 Band (NFM) 161.985 MHz dB 8 4 min

(NFM) 173.225 MHz dB 8 4 Min

(WFM) 197.450 MHz dB 42 15 Min

VHF High 2 Band (AM) 272.950 MHz dB 8 5 Min

UHF Band (AM) 325.050 MHz dB 8 5 Min

(NFM) 406.875 MHz dB 8 4 Min

Public Svc (NFM) 857.150 MHz dB 8 4 Min

1200MHz Band (NFM) 1299.925 MHz dB 8 4 Min
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Distortion

ITEM UNIT NOMINAL LIMIT
(FM) 72.515 MHz % 1.8 6 Max

(FMB) 107.500 MHz % 0.7 6 Max

(AM) 127.175 MHz % 0.7 10 Max

(NFM) 161.985 MHz % 1.2 10 Max

(WFM) 197.450 MHz % 0.3 6 Max

Attenuator

ITEM UNIT NOMINAL LIMIT
(NFM) 40.840 MHz dB 33 10 Min

(FM) 72.515 MHz dB 33 10 Min

(AM) 127.175 MHz dB 33 10 Min

(NFM) 161.985 MHz dB 31 10 Min

(AM) 272.950 MHz dB 27 10 Min

(NFM) 406.875 MHz dB 24 10 Min

(NFM) 857.150 MHz dB 22 10 Min

Close Call Sensitivity (No Modulation)

ITEM UNIT NOMINAL LIMIT
(NFM) 40.840 MHz dBm -53 -30 Max

(FM) 72.515 MHz dBm -54 -30 Max

(AM) 127.175 MHz dBm -54 -30 Max

(NFM) 161.985 MHz dBm -54 -30 Max

(AM) 272.950 MHz dBm -54 -30 Max

(NFM) 406.875 MHz dBm -52 -30 Max

(NFM) 857.150 MHz dBm -52 -30 Max

(NFM) 1299.925 MHz dBm -57 -30 Max
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S-Meter Sensitivity

ITEM UNIT NOMINAL LIMIT
RF Input : 1mV (No Modulation)

(NFM) 40.840 MHz Digit 5 4 Min

(NFM) 161.985 MHz Digit 5 4 Min

(AM) 272.950 MHz Digit 5 4 Min

(NFM) 406.875 MHz Digit 5 4 Min

(NFM) 857.150 MHz Digit 5 4 Min

(NFM) 1299.925 MHz Digit 5 4 Min

RF Input : OFF

(NFM) 40.840 MHz Digit 0 1 Max

(NFM) 161.985 MHz Digit 0 1 Max

(AM) 272.950 MHz Digit 0 1 Max

(NFM) 406.875 MHz Digit 0 1 Max

(NFM) 857.150 MHz Digit 0 1 Max

(NFM) 1299.925 MHz Digit 0 1 Max
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SIMPLIFIED EU DECLARATION OF CONFORMITY

Hereby. Uniden Holdings Corporation declares that the radio equipment type Uniden True I/Q 
Scanner SDS100E is in compliance with the Directive 2014/53/EU.

The full text of the EU declaration of conformity is available at the following internet address: 

www.avera.eu//downloads

Manufactured by:

Uniden Japan Corporation
2-12-7 Hatchobori, Chuo-ku, 
Tokyo, 104-8512 
JAPAN
ues@uniden.co.jp
www.uniden.co.jp

Imported into the EU by:

Avera-Distributing
Hazeldonk 6259
4836 LG BREDA
THE NETHERLANDS
info@avera.eu
www.avera.eu






